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NDX900 AND TRAKTOR LE 2 SETUP 

 
1. DRIVER INSTALLATION (WINDOWS USERS) 

 
1. Insert the included software installation disc into your computer's DVD-ROM drive. 
2. Navigate to the ASIO4ALL directory and find the ASIO4ALL.exe file. 
3. Follow the on-screen prompts to install the included low latency ASIO4ALL driver. 

 
2. SOFTWARE INSTALLATION (TRAKTOR LE2) 
 
1. Insert the included TRAKTOR LE 2 software installation disc into your computer's DVD-ROM drive. 

Windows: Double-click "My Computer" then double-click the disc. Once the disc's contents are shown, double-
click the TRAKTOR LE 2 installer file (.exe). 
Mac: Double-click the disc. Once the disc's contents are shown, double-click the TRAKTOR LE 2 installer file 

(.dmg). 
2. Follow the on-screen instructions to install the software. 

Note: TRAKTOR LE 2's install "wizard" may ask you to install a hardware driver. Click "Next" or "Continue" to 
skip past these screens.   

3. Connect your NDX900 to your computer. (If you are using Windows, you may see several dialog boxes in the 
corner of your screen indicating it is "recognizing" the hardware for the first time.  Wait a minute until this is 
complete.) 

4. Open TRAKTOR LE 2. In the window that appears, click the "Activate" button to register the software. The Native 
Instruments Service Center will launch.  (You will need to be connected to the internet to access the Service 
Center to register your software.) 

5. In the Service Center login window, click "Create new User Account" (if you do not already have one) and follow 
the on-screen instructions to complete your registration.  (You will need the serial number on the included DVD 
sleeve to do this.) 
Note: For additional assistance and information, you can find TRAKTOR LE 2's manual by going to the software's 
"Help" menu.  

 
3. NDX900 SETUP 
 
1. Connect the NDX900 Controller to a rear USB Port on your computer. Power on the NDX900 Controller. 
2. Press SOURCE.  
3. Rotate the PARAMETER knob until the screen reads <<SOURCE>> USB-MIDI. 
4. Press the PARAMETER knob (like a button) to confirm your selection. 
5. To set the NDX900 to be the default playback device: 
 
Windows XP: Go to the Windows Control Panel X Sounds and Audio Devices X Audio tab and for the default 
Playback device select ‘USB Audio Codec’. Tick the box for ‘Use only default devices’.  
 
Windows Vista: Go to Start X Control Panel X Sound (in Classic View). Then, click on the Playback tab and 
highlight ‘Speakers- USB Audio Codec’.  Click Apply to accept the settings.   
 
Windows 7: Go to the Windows Control Panel X Sound and for the Playback tab select ‘Speakers- USB Audio 
Codec’.  
 
Mac OSX: See the AGGREGATE DEVICES section. 
 
6. Set NDX900 as your default playback device. Follow the same steps above if you have a second NDX900 

controller. 
 
AGGREGATE DEVICES (MAC)  
1. Click on the Mac desktop so that Finder is displayed in the upper-left of the screen. 
2. Select the Go menu from the top of the screen and choose Utilities. 
3. In the window that opens, double click Audio MIDI Setup. 
4. Once the Audio MIDI Setup utility is open, select the Audio tab and at the top of the screen; select the Audio 

menu and choose Open Aggregate Device Editor. 
5. In the window that opens, click the + button.  
6. Under Structure should be listed four USB Audio Codec devices. If using two NDX900s, they will be listed as 

each having 2 inputs and each with two 2 outputs. Place a check next to each of the four USB Audio Codec 
devices that are listed. This will merge all four USB Audio Codec devices into one device, allowing TRAKTOR 
LE2 to access all of the inputs and outputs at once. 

7. Click Done. 
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4. TRAKTOR LE 2 SETUP TRAKTOR LE 2 Setup Wizard  
 
1. With the NDX900 connected to the computer through USB, launch TRAKTOR LE 2. 
2. Next, in TRAKTOR LE 2, go to Help > Start Setup Wizard. 
3. In the window that opens, click Next to get to the Traktor LE2 Controller Selection. 
4. Next to Are you using an external controller? select Yes, then click Next. 
5. Set manufacturer to Numark. If are using two NDX900 Controllers, set model to NDX900 LE Dual Deck.  
If you are using a single NDX900, set model to ‘NDX900 LE Single Deck’ and click Next. 
6. In the Mixer Setup page next to Are you using an external mixer? Select No.  
7. Click Next and review the settings you have chosen. 
8. Click Finish.   
TRAKTOR LE 2 Audio Setup (PC)  
1. Go into the Preferences menu in TRAKTOR LE 2 to configure the Audio Setup. 
2. Go to File > Preferences. 
3. In the Audio Device area if you are on a Windows platform, make sure that ASIO4ALL is selected. Click on the 

Settings button to open the ASIO4ALL dialog box. Make sure the status under USB Audio Device is ‘active’ 
(highlighted in blue) and then close out of the box. This will allow audio output from TRAKTOR LE 2 to be sent 
through the USB connection to the NDX900 and output through its USB Audio RCA output. 

4. To set up your audio input and output configuration click on Output Routing on the left-hand side of the 
preferences window 

5. Under Mixing Mode, choose External. 
6. Under Output Deck A, choose USB Audio Codec 1 for ‘L’ and USB Audio Codec 2 for ‘R’. 
7. Under Output Deck B, choose USB Audio Codec 1 for ‘L’ and USB Audio Codec 2 for ‘R’. 

If using 2 NDX900 decks:  
 • Under Output Deck A, choose USB Audio Codec 1 for ‘L’ and USB Audio Codec 1 for ‘R’. 
 • Under Output Deck B, choose USB Audio Codec 2 for ‘L’ and USB Audio Codec 2 for ‘R’. 

 
 
TRAKTOR LE 2’s Audio Setup (Mac)  

1. Click the TRAKTOR LE 2 menu in the upper-left of the screen, and select Preferences. 
2. On the left-hand side of the window that opens, click the + next to Audio Setup. 
3. Next, under Audio Setup on the left, click Soundcard. 
4. On the right-hand side of window, next to Audio Device, select Aggregate Device. 
5. On the left-hand side of the TRAKTOR preferences window, under Audio Setup on the left, click Output Routing. 
6. On the right-hand side of window, next to Mixer Mode, select External. 
7. Next to Out Channel A, for Left, select Aggregate Device Out 1. For Right, select Aggregate Device Out 2. 
8. Next to Out Channel B, for Left, select Aggregate Device Out 1. For Right, select Aggregate Device Out 2. 
      If using 2 NDX900s, for the Left, select Aggregate Device Out 3. For Right, select Aggregate Device Out 4. 

TRAKTOR LE 2 Controller Manager Setup  
If you are using a single NDX900:  
Setup your NDX900 to control a Deck in TRAKTOR LE 2:  
 
1. Click on Controller Manager on the left-hand side of the Preferences window. 
2. Next to Device, select NDX900 Single Deck Controls.  
3. Under In-Port, select Numark NDX900. 
4. Under Out-Port, select Numark NDX900. 
5. Next to Device Target, select Focus. 
6. The NDX900 will control whichever deck is focused (selected) on the TRAKTOR LE 2 main screen. 
7. To change which deck is focused, you can either click the RECALL button in the upper-right corner of the NDX900 

hardware, use your keyboard or mouse to select deck A or B from within the TRAKTOR LE 2 software.   
8. Click Close.  
 
If you are using two NDX900 units: 
 
1. Click on Controller Manager on the left-hand side of the preferences window. 
2. Next to Device, select NDX900 Deck A Controls (whichever deck you connected to the computer first will 

become ‘Deck A’.)  
3. Under In-Port, select Numark NDX900. 
4. Under Out-Port, select Numark NDX900. 
5. Next to Device, select NDX900 Deck B Controls. 
6. Under In-Port, select Numark NDX 900 #2. 
7. Under Out-Port select NDX 900 #2. 
8. Click Close.  
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CONTROL MAP 
 
 
1. EJECT  
2. USB MASTER 
3. SOURCE 
4. TRACK KNOB 
5. BACK  
6. PLAY  
7. PAUSE  
8. CUE  
9. JOG WHEEL 
10. SCRATCH 
11. SEARCH 
12. STOP / START TIME 
13. TAP 
14. PITCH / KEYLOCK  
15. PITCH FADER 
16. PITCH BEND 
17. BLEEP / REVERSE SWITCH  
18. LOOP IN / OUT / RELOOP  
19. TRIGGER BUTTONS  
20. SHIFT 
21. REC  
22. (BUTTON) MODE  
23. FX  
24. FX SELECT 
25. WET / DRY FADER  
26. PARAMETER 
27. PROG (Program)  
28. TIME  
29. RECALL / STORE 
30. (PLAY) MODE  
31. LCD DISPLAY 
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CONFIGURACIÓN DE NDX900 Y TRAKTOR LE 2 

 
1. INSTALACIÓN DE LOS DRIVERS (USUARIOS DE WINDOWS) 

 
1. Inserte el disco de instalación del software incluido en el lector de DVD-ROM de la computadora. 
2. Navegue al directorio ASIO4ALL y localice el archivo ASIO4ALL.exe. 
3. Siga las indicaciones de la pantalla para instalar el driver ASIO4ALL de baja latencia incluido. 

 
2. INSTALACIÓN DEL SOFTWARE (TRAKTOR LE2) 
 
1. Inserte el disco de instalación de TRAKTOR LE 2 incluido en el lector de DVD-ROM de la computadora. 

Windows: Haga doble clic en "My Computer" (Mi PC) y luego doble clic en el disco. Una vez que se muestre el 
contenido del disco, haga doble clic en el archivo instalador de TRAKTOR LE 2 (.exe). 
Mac: Haga doble clic en el disco. Una vez que se muestre el contenido del mismo, haga doble clic en el archivo 
instalador de TRAKTOR LE 2 (.dmg). 

2. Siga las instrucciones de la pantalla para instalar el software. 
Nota: El "asistente" de instalación de TRAKTOR LE 2 puede solicitarle instalar un driver de hardware. Haga clic 
en "Next" (Siguiente) o "Continue" (Continuar) para saltear estas pantallas.   

3. Conecte el NDX900 a su computadora. (Si usa Windows, puede ver varios cuadros de diálogo en la esquina de la 
pantalla, que le indican que está "reconociendo" el hardware por primera vez. Espere un minuto hasta que 
termine.) 

4. Abra TRAKTOR LE 2. En la ventana que aparece, haga clic en el botón "Activate" (Activar) para registrar el 
software. Se abre Service Center (Centro de Servicios) de Native Instruments. (Debe estar conectado a Internet 
para acceder al Centro de Servicios a fin de registrar su software.) 

5. En la ventana de inicio de sesión de Service Center, haga clic en "Create new User Account" (Crear cuenta de 
usuario nuevo) (si no tiene ya una) y siga las instrucciones de la pantalla para terminar el registro. (Para hacerlo, 
necesita el número de serie que figura en la funda del DVD incluido.) 
Nota: Para obtener asistencia e información adicionales, puede encontrar el manual de TRAKTOR LE 2 yendo al 
menú "Help" (Ayuda) del software.  

 
3. CONFIGURACIÓN DE NDX900 
 
1. Conecte el controlador NDX900 a un puerto USB trasero de la computadora. Encienda el controlador NDX900. 
2. Pulse SOURCE (Fuente).  
3. Gire la perilla PARAMETER (Parámetro) hasta que aparezca en la pantalla <<SOURCE>> USB-MIDI. 
4. Pulse la perilla PARAMETER (como si fuera un botón) para confirmar su selección. 
5. Para configurar el NDX900 como dispositivo de reproducción predeterminado: 
 
Windows XP: Vaya a la pestaña del Control Panel (Panel de control) de WindowsX Sounds and Audio Devices 
(Dispositivos de sonido y audio)X Audio y seleccione ‘USB Audio Codec’ (Códec de audio USB) como dispositivo de 
reproducción predeterminado. Marque la casilla "Use only default devices" (Usar sólo los dispositivos 
predeterminados).  
 
Windows Vista: Vaya a Start X Control Panel X Sound (Inicio > Panel de control > Sonido) (en la vista clásica). 
Luego, haga clic en la pestaña Playback (Reproducción) y resalte ‘Speakers- USB Audio Codec’ (Altavoces - Códec 
de audio USB). Haga clic en Apply (Aplicar) para aceptar los valores de configuración.   
 
Windows 7: Vaya a Control Panel (Panel de control) de WindowsX Sound (Sonido) y seleccione en la pestaña 
Playback (Reproducción) ‘Speakers- USB Audio Codec’ (Altavoces - Códec de audio USB).  
 
Mac OSX: Consulte la sección DISPOSITIVOS AGREGADOS. 
 
6. Configure NDX900 como dispositivo de reproducción predeterminado. Siga los mismos pasos arriba indicados si 

tiene un segundo controlador NDX900. 
 
DISPOSITIVOS AGREGADOS (MAC)  
1. Haga clic en el escritorio de Mac de modo que aparezca Finder (Buscador) en la parte superior izquierda de la 

pantalla. 
2. Seleccione el menú Go (Ir) en la parte superior de la pantalla y elija Utilities(Utilidades). 
3. En la ventana que se abre, haga doble clic en Audio MIDI Setup (Configuración MIDI de audio). 
4. Una vez abierta la utilidad Audio MIDI Setup, seleccione la pestaña Audio y, en la parte superior de la pantalla, 

seleccione el menú Audio y elija Open Aggregate Device Editor(Abrir editor de dispositivos agregados). 
5. En la ventana que se abre, haga clic en el botón +.  
6. Bajo Structure (Estructura) debe aparecer una lista de cuatro dispositivos USB Audio Codec. Si utiliza dos 

NDX900, están en la lista como con 2 entradas y 2 salidas cada uno. Coloque la marca de selección en cada 
uno de los cuatro dispositivos USB Audio Codec de la lista. De esta forma se combinan los cuatro dispositivos 
USB Audio Codec en uno, permitiendo que TRAKTOR LE2 acceda a todas las entradas y salidas al mismo 
tiempo. 

7. Haga clic en Save (Guardar).    
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4. CONFIGURACIÓN DE TRAKTOR LE 2 Asistente de configuración de TRAKTOR LE 2 
 
1. Con el NDX900 conectado a la computadora por USB, abra TRAKTOR LE 2. 
2. A continuación, en TRAKTOR LE 2, vaya a Help > Start Setup Wizard (Ayuda > Abrir asistente de 

configuración). 
3. En la ventana que aparece, haga clic en Next (Siguiente) para abrir Traktor LE2 Controller Selection (Selección 

de controladores de Traktor LE2). 
4. Junto a Are you using an external controller? (¿Está usando un controlador externo) seleccione Yes(Sí) y 

luego haga clic en Next. 
5. Configure manufacturer (Fabricante) como Numark. Si utiliza dos controladores NDX900, configure model 

(modelo) como NDX900 LE Dual Deck. Si utiliza un solo NDX900, configure model como ‘NDX900 LE Single 
Deck y haga clic en Next. 

6. En la página Mixer Setup (Configuración del mezclador) junto a Are you using an external mixer? (¿Utiliza un 
mezclador externo?) seleccione No.  

7. Haga clic en Next y revise los valores de parámetros que eligió. 
8. Haga clic en Finish (Terminar).   
Configuración de audio de TRAKTOR LE 2 (PC)  
1. Vaya al menú Preferences (Preferencias) de TRAKTOR LE 2 para configurar Audio Setup (Configuración de 

audio). 
2. Vaya a File (Archivo) > Preferences. 
3. En el área Audio Device (Dispositivo de audio) si está en una plataforma Windows, asegúrese de que esté 

seleccionado ASIO4ALL. Haga clic en el botón Settings (Configuración) para abrir el cuadro de diálogo 
ASIO4ALL. Asegúrese de que el estado en USB Audio Device es ‘activo (resaltado en azul) y luego salga del 
cuadro de diálogo. De esta forma permite que la salida de audio de TRAKTOR LE 2 se envíe por la conexión USB 
al NDX900 y salga por su salida USB Audio RCA. 

4. Para configurar su entrada y salida de audio, haga clic en Output Routing (Enrutamiento de salida) en el lado 
izquierdo de la ventana de preferencias 

5. En Mixing Mode (Modo de mezcla), elija External (Externa). 
6. En Output Deck A (Bandeja de salida A), elija USB Audio Codec 1 for ‘L’ and USB Audio Codec 2 for ‘R’ 

(Códec de audio USB 1 para el lado izquierdo y Códec de audio USB 2 para el lado derecho). 
7. En Output Deck B (Bandeja de salida B), elija USB Audio Codec 1 for ‘L’ and USB Audio Codec 2 for ‘R’ 

(Códec de audio USB 1 para el lado izquierdo y Códec de audio USB 2 para el lado derecho). 
Si utiliza 2 bandejas NDX900:  
 • En Output Deck A (Bandeja de salida A), elija USB Audio Codec 1 for ‘L’ and USB Audio Codec 1 for ‘R’ 

(Códec de audio USB 1 para el lado izquierdo y Códec de audio USB 1 para el lado derecho). 
 • En Output Deck B (Bandeja de salida B), elija USB Audio Codec 2 for ‘L’ and USB Audio Codec 2 for ‘R’ 

(Códec de audio USB 2 para el lado izquierdo y Códec de audio USB 2 para el lado derecho). 
 
Configuración de audio de TRAKTOR LE 2 (Mac)  
1. Haga clic en el menú TRAKTOR LE 2 de la parte superior izquierda de la pantalla y seleccione Preferences 

(Preferencias). 
2. En el lado izquierdo de la ventana que se abre, haga clic en el + que está junto a Audio Setup (Configuración de 

audio). 
3. A continuación, en Audio Setup a la izquierda, haga clic en Soundcard (Tarjeta de sonido). 
4. En el lado derecho de la ventana, junto a Audio Device (Dispositivo de audio), seleccione Aggregate Device 

(Dispositivo agregado). 
5. En el lado izquierdo de la ventana de preferencias de TRAKTOR, en Audio Setup a la izquierda, haga clic en 

Output Routing (Enrutamiento de salida). 
6. En el lado derecho de la ventana, junto a Mixer Mode (Modo de mezclador), seleccione External (Externo). 
7. Junto a Out Channel A (Canal de salida A), para Left (Lado izquierdo), seleccione Aggregate Device Out 1 

(Salida de dispositivo agregado 1). Para Right (Lado derecho), seleccione Aggregate Device Out 2. 
8. Junto a Out Channel B (Canal de salida B), para Left (Lado izquierdo), seleccione Aggregate Device Out 1 

(Salida de dispositivo agregado 1). Para Right (Lado derecho), seleccione Aggregate Device Out 2. 
     Si utiliza 2 NDX900, para Left, seleccione Aggregate Device Out 3. Para Right, seleccione Aggregate Device 

Out 4. 
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Configuración del Controller Manager en TRAKTOR LE 2  

Si utiliza un solo NDX900:  
Configure su NDX900 para controlar una bandeja en TRAKTOR LE 2:  
 
1. Haga clic en Controller Manager (Administrador del controlador) en el lado izquierdo de la ventana Preferences. 
2. Junto a Device (Dispositivo), seleccione NDX900 Single Deck Controls (Controles de una sola bandeja de 

NDX900).  
3. En In-Port (Puerto de entrada), seleccione Numark NDX900. 
4. En Out-Port (Puerto de salida), seleccione Numark NDX900. 
5. Junto a Device Target (Dispositivo destinatario), seleccione Focus (Enfoque). 
6. El NDX900 controla la bandeja que está enfocada (seleccionada) en la bandeja principal de TRAKTOR LE 2. 
 
7. Para cambiar la bandeja enfocada, puede hacer clic en el botón RECALL (Recuperar) de la esquina superior 

derecha del hardware del NDX900 o use su teclado o mouse para seleccionar bandeja A o B dentro del software 
TRAKTOR LE 2.   

8. Haga clic en Close (Cerrar).  
 
Si utiliza dos unidades NDX900: 
 
1. Haga clic en Controller Manager (Administrador del controlador) en el lado izquierdo de la ventana de 

preferencias. 
2. Junto a Device, seleccione NDX900 Deck A Controls (Controles de la bandeja A de NDX900) (la bandeja que 

haya conectado primero a la computadora es la ‘Bandeja A.)  
3. En In-Port (Puerto de entrada), seleccione Numark NDX900. 
4. En Out-Port (Puerto de  salida), seleccione Numark NDX900. 
5. Junto a Device (Dispositivo), seleccione NDX900 Deck B Controls (Controles de la bandeja B de NDX900). 
6. En In-Port (Puerto de entrada), seleccione Numark NDX900 #2. 
7. En Out-Port (Puerto de salida) seleccione NDX 900 #2. 
8. Haga clic en Close (Cerrar).  
 
 
MAPA DEL CONTROL 
 
 
1. EXPULSAR  
2. MASTER DE USB 
3. FUENTE 
4. PERILLA DE PISTA 
5. RETROCEDER  
6. REPRODUCIR  
7. PAUSA  
8. CUE  
9. RUEDA DE AVANCE LENTO 
10. RAYADO 
11. BÚSQUEDA 
12. TIEMPO DE PARADA / INICIO 
13. TAP (GOLPE) 
14. PITCH / BLOQUEO DE TONALIDAD  
15. FADER DE PITCH 
16. INFLEXIÓN DE PITCH 
17. CONMUTADOR DE BLEEP / REVERSA  
18. ENTRADA / SALIDA / REPETICIÓN DEL 

LOOP  
19. BOTONES DE DISPARO  
20. FUNCIONES SECUNDARIAS 
21. GRABAR  
22. MODO (BOTÓN)  
23. EFECTOS  
24. SELECCIÓN DE EFECTO 
25. FADER DE SONIDO CON EFECTOS / 

SONIDO ORIGINAL  
26. PARÁMETRO 
27. PROGRAMA  
28. TIEMPO  
29. RECUPERAR / ALMACENAR 
30. MODO (REPRODUCCIÓN)  
31. PANTALLA LCD 
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INSTALLATION DU NDX900 ET DU TRAKTOR LE 2 

 
INSTALLATION DES PILOTES (UTILISATEURS WINDOWS) 

 
1. Insérez le disque du logiciel dans le lecteur DVD-ROM de votre ordinateur. 
2. Parcourez le répertoire ASIO4ALL et recherchez le fichier ASIO4ALL.exe.  
3. Suivez les instructions à l’écran pour installer le pilote ASIO4ALL à faible latence.  

 
INSTALLATION DU LOGICIEL TRAKTOR LE2 
 
1. Insérez le disque TRAKTOR LE 2 dans le lecteur DVD-ROM de votre ordinateur. 

Windows : Double-cliquez sur « Poste de travail », puis double-cliquez sur disque. Une fois le contenu du DVD-
ROM affiché, double-cliquez sur le fichier d'installation du TRAKTOR LE 2 (.exe). 
Mac : Double-cliquez le disque. Une fois le contenu du DVD-ROM affiché, double-cliquez sur le fichier 
d'installation du TRAKTOR LE 2 (.dmg). 

2. Suivez les instructions à l’écran pour installer le logiciel. 
Remarque : Il se peut que l'assistant d’installation du TRAKTOR LE 2 vous demande de faire l’installation du 
pilote matériel. Cliquez sur « Next » ou sur « Continue » afin de sauter cette étape.  

3. Branchez le NDX900 à votre ordinateur. Sous Windows, il se peut que quelques boîtes de dialogue s'affichent 
indiquant que l’ordinateur recherche le nouveau matériel. Veuillez attendre environ une minute qu’il ait terminé. 

4. Lancez TRAKTOR LE 2. Dans la fenêtre qui s’affiche, cliquez sur « Activate » afin de procéder à l'inscription du 
logiciel. L’assistant Native Instruments Service Center devrait s’ouvrir. Vous devez être connecté à l’Internet pour 
accéder au Centre de service afin de procéder à l'inscription du logiciel. 

5. Dans la fenêtre de connexion du centre de service, cliquez sur « Create new User Account » (si vous n’en avez 
pas déjà un), et suivez les instructions à l’écran afin de compléter l’inscription. Vous devez avoir en main le 
numéro de série du logiciel qui se trouve sur la pochette du DVD. 
Remarque : Pour plus d'assistance et d'information, consultez le guide d'utilisation du TRAKTOR LE 2 en cliquant 
sur le menu « Help ».  

 
CONFIGURATION DU NDX900 
 
1. Branchez le contrôleur NDX900 sur un des ports USB de votre ordinateur. Mettez le NDX900 en marche. 
2. Appuyez sur SOURCE.  
3. Tournez le bouton PARAMETER jusqu’à ce <<SOURCE>> USB-MIDI s’affiche. 
4. Appuyez sur le bouton PARAMETER afin de confirmer la sélection. 
5. Pour configurer le NDX900 comme appareil de lecture par défaut : 
 
Windows XP : Cliquez sur Panneau de configuration  X Sons et périphériques audio X l’onglet « Audio », puis sous 
« Lecture audio », sélectionnez « USB Audio codec  » comme l’appareil par défaut. Cochez la case « Use only 
default devices ».  
 
Windows Vista : Cliquez sur Démarrer X Panneau de configuration X Son (en mode Classique). Cliquez sur l’onglet 
Lecture et sélectionnez « Haut-parleurs - USB audio codec ». Cliquez sur Appliquer afin de confirmer les 
modifications.  
 
Windows 7 : Cliquez sur Panneau de configuration X Sons X puis sur l’onglet Lecture sélectionnez « Haut-parleurs 
- USB audio codec ».  
 
Mac OSX : Consultez la section PÉRIPHÉRIQUES AGRÉGÉS. 
 
6. Configurez le NDX900 comme l’appareil de lecture par défaut. Suivez les mêmes étapes que celle ci-dessus si 

vous avez un deuxième contrôleur NDX900. 
 
PÉRIPHÉRIQUES AGRÉGÉS (MAC)  
1. Cliquez sur le bureau Mac afin de faire apparaître le Finder dans le coin supérieur gauche de l’écran. 
2. Cliquez sur le menu Aller dans le haut de l’écran et sélectionnez Utilitaires. 
3. Double-cliquez sur Configuration audio et MIDI dans la fenêtre qui apparaît. 
4. À partir de l’utilitaire de configuration audio et MIDI, cliquez sur l’onglet Audio dans le haut de l’écran et 

sélectionnez « Ouvrir l’éditeur de périphérique agrégé ». 
5. Cliquez le bouton + dans la fenêtre qui apparaît.  
6. Sous Structure, il devrait y avoir quatre périphériques USB Audio Codec. Si vous utilisez deux NDX900, ils 

apparaîtront avec chacun 2 entrées et deux sorties. Cochez les quatre périphériques USB Audio Codec listés. 
Ceci permet de fusionner les quatre périphériques USB Audio Codec en un périphérique, permettant au 
TRAKTOR LE 2 d’accéder à toutes les entrées et sorties en même temps. 

7. Cliquez sur Terminer. 
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CONFIGURATION DU TRAKTOR LE 2  
 
1. Sur le NDX900 qui est branché à l’ordinateur via la connexion USB, lancez TRAKTOR LE 2. 
2. À partir du TRAKTOR LE 2, cliquez sur Help > Start Setup Wizard. 
3. Cliquez sur Next dans la fenêtre qui apparaît afin d’accéder à Traktor LE2 Controller Selection. 
4. À côté du champ Are you using an external controller?, sélectionnez Yes, puis cliquez sur Next. 
5. Réglez le champ Manufacturer à Numark. Si vous utilisez deux contrôleurs NDX900, réglez le champ Model à 

NDX900 LE Dual Deck. Si vous n’utilisez qu’un contrôleur NDX900, réglez-le à NDX900 LE Single Deck, puis 
cliquez sur Next. 

6. Dans la fenêtre de configuration de la console de mixage à côté du champ Are you using an external mixer?, 
sélectionnez No.  

7. Cliquez sur Next et vérifiez les réglages choisis. 
8. Cliquez sur Finish.   
Configuration audio du TRAKTOR LE 2 (PC)  
1. Accédez au menu des préférences du TRAKTOR LE 2 afin de faire la configuration audio. 
2. Cliquez sur File > Preferences. 
3. Dans la section Audio Device sous les plateformes Windows, veuillez vous assurer que ASIO4ALL est 

sélectionné. Cliquez sur le bouton Settings afin d’ouvrir la boîte de dialogue ASIO4ALL. Veuillez vous assurer que 
USB Audio Device a été activé (surbrillance bleue), puis fermez la fenêtre. Ceci permettra à la sortie audio du 
TRAKTOR LE 2 sera routée via la connexion USB au NDX900 et via sa sortie audio RCA USB. 

4. Pour configurer l’entrée et la sortie audio, cliquez sur Output Routing sur le côté gauche de la fenêtre des 
préférences. 

5. Sous Mixing Mode, sélectionnez External. 
6. Sous Output Deck A, sélectionnez USB Audio Codec 1 for ‘L’ and USB Audio Codec 2 for ‘R’. 
7. Sous Output Deck B, sélectionnez USB Audio Codec 1 for ‘L’ and USB Audio Codec 2 for ‘R’. 

Si vous utilisez deux contrôleurs NDX900 :  
 Sous Output Deck A, sélectionnez USB Audio Codec 1 for ‘L’ and USB Audio Codec 1 for ‘R’. 
 Sous Output Deck B, sélectionnez USB Audio Codec 2 for ‘L’ and USB Audio Codec 2 for ‘R’. 
 
Configuration audio du TRAKTOR LE 2’s (Mac)  
1. Cliquez sur le menu TRAKTOR LE 2 dans le coin supérieur gauche de l’écran et sélectionnez Preferences. 
2. Cliquez sur le bouton + à côté de Audio Setup à gauche de la fenêtre qui s’ouvre. 
3. À gauche, sous Audio Setup, cliquez sur Soundcard. 
4. À droite de la fenêtre, dans le champ Audio Device, sélectionnez Aggregate Device. 
5. À partir de la fenêtre des préférences TRAKTOR LE 2, à gauche, sous Audio Setup, cliquez sur Output Routing. 
6. À droite de la fenêtre, dans le champ Mixer Mode, sélectionnez External. 
7. Dans le champ Out Channel A, pour Left, sélectionnez Aggregate Device Out 1. Pour Right, sélectionnez 

Aggregate Device Out 2. 
8. Dans le champ Out Channel B, pour Left, sélectionnez Aggregate Device Out 1. Pour Right, sélectionnez 

Aggregate Device Out 2. Si vous utilisez deux contrôleurs NDX900, pour Left, sélectionnez Aggregate Device 
Out 3. Pour Right, sélectionnez Aggregate Device Out 4. 

Configuration du contrôleur TRAKTOR LE 2  
Si vous n’utilisez qu’un contrôleur NDX900 :  
Configuration du NDX900 comme contrôleur d’un module du TRAKTOR LE 2 :  
 
1. Cliquez sur Controller Manager à gauche dans la fenêtre Preferences. 
2. Dans le champ Device, sélectionnez NDX900 Single Deck Controls.  
3. Sous In-Port, sélectionnez Numark NDX900. 
4. Sous Out-Port, sélectionnez Numark NDX900. 
5. Dans le champ Device Target, sélectionnez Focus. 
6. Le NDX900 commandera le module sélectionné (focused) dans la fenêtre principale du TRAKTOR LE 2. 
7. Pour changer le module sélectionné, vous pouvez cliquer sur le bouton RECALL dans le coin supérieur droit du 

HDX900, ou encore, utiliser le clavier ou la souris afin de sélectionner le module A ou B à partir du logiciel 
TRAKTOR LE 2.  

8. Cliquez sur Close.  
 
Si vous utilisez deux contrôleurs NDX900: 
 
1. Cliquez sur Controller Manager à gauche dans la fenêtre Preferences. 
2. Dans le champ Device, sélectionnez NDX900 Deck A Controls (le module que vous avez branché à l’ordinateur 

en premier devient le module A).  
3. Sous In-Port, sélectionnez Numark NDX900. 
4. Sous Out-Port, sélectionnez Numark NDX900. 
5. Dans le champ Device, sélectionnez NDX900 Deck B Controls. 
6. Sous In-Port, sélectionnez Numark NDX 900 #2. 
7. Sous Out-Port, sélectionnez NDX 900 #2. 
8. Cliquez sur Close.  
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BOUTONS DE COMMANDE 
 
 
1. TOUCHE D’ÉJECTION  
2. PORT USB PRINCIPAL 
3. SOURCE 
4. BOUTON PISTE 
5. RETOUR  
6. LECTURE  
7. PAUSE  
8. RECHERCHE  
9. MOLETTE 
10. SCRATCH 
11. RECHERCHE 
12. HEURE D’ARRÊT/DÉPART 
13. TAP 
14. TONALITÉ/VERROUILLAGE  
15. ATTÉNUATEUR DE TONALITÉ 
16. MODIFICATION TEMPORAIRE DE LA 

TONALITÉ ET DE LA VITESSE 
17. LECTURE INVERSÉE  
18. ENTRÉE/SORTIE DE 

BOUCLE/REBOUCLAGE  
19. TOUCHES D’ACTIVATION  
20. TOUCHE SHIFT/AUTRES FONCTIONS 
21. ENREGISTREMENT  
22. MODE  
23. EFFETS  
24. SÉLECTEUR D’EFFET  
25. POTENTIOMÈTRE DU SIGNAL 

TRAITÉ/NON TRAITÉ  
26. PARAMÈTRE 
27. PROGRAMME  
28. DURÉE  
29. RAPPEL/SAUVEGARDE 
30. MODE (DE LECTURE)  
31. ÉCRAN À CRISTAUX LIQUIDES 
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SETUP DI NDX900 E TRAKTOR LE 2 

 
1. INSTALLAZIONE DEI DRIVER (UTENTI WINDOWS) 

 
1. Inserire il disco recante il software d'installazione in dotazione nel drive DVD-ROM del computer. 
2. Navigare fino alla cartella ASIO4ALL e individuare il file ASIO4ALL.exe. 
3. Seguire le istruzioni su schermo per installare i driver ASIO4ALL a bassa latenza in dotazione. 

 
2. INSTALLAZIONE DEL SOFTWARE (TRAKTOR LE2) 
 
1. Inserire il disco recante il software d'installazione del TRAKTOR LE 2 in dotazione nel drive DVD-ROM del 

computer. 
Windows: fare doppio clic su "Computer" quindi fare doppio clic sul disco. Non appena compaiono i contenuti del 
disco, fare doppio clic sul file di installazione del TRAKTOR LE 2 (.exe). 
Mac: fare doppio clic sul disco. Non appena compaiono i contenuti del disco, fare doppio clic sul file di 
installazione del TRAKTOR LE 2 (.dmg).  

2. Seguire le istruzioni su schermo per installare il software. 
Nota bene: la procedura guidata di installazione del TRAKTOR LE 2 potrebbe chiedere di installare un driver 
hardware. Cliccare su "Next" o su "Continue" per saltare queste schermate.   

3. Collegare l'NDX900 al computer. (Se si utilizza Windows, possono comparire diverse finestre di dialogo 
nell'angolo dello schermo, a indicare che sta "riconoscendo" l'hardware per la prima volta. Attendere un minuto 
fino a che questa operazione non sia completata.) 

4. Aprire il TRAKTOR LE 2. Nella finestra che compare, cliccare il tasto "Activate" (attiva) per registrare il software. 
Verrà lanciato il centro servizi Native Instruments. (Sarà necessario essere collegati a Internet per accedere al 
centro servizi per registrare il software.) 

5. Nella finestra di login del centro servizi, fare clic su "Create new User Account" (crea nuovo account utente) (se 
non se ne possiede ancora uno) e seguire le istruzioni che compaiono su schermo per completare la 
registrazione.  (Per farlo, occorrerà il numero di serie presente sulla custodia del DVD in dotazione.) 
Nota bene: per ulteriore assistenza e maggiori informazioni, è possibile trovare il manuale del TRAKTOR LE 2 
recandosi nel menu "Help" del software.  

 
3. SETUP DELL'NDX900 
 
1. Collegare il controller NDX900 ad una porta USB del computer. Accendere il Controller NDX900. 
2. Premere SOURCE.  
3. Ruotare la manopola PARAMETER fino a quando sullo schermo non compare <<SOURCE>> USB-MIDI. 
4. Premere la manopola PARAMETER (come se fosse un pulsante) per confermare la scelta. 
5. Per configurare l'NDX900 come dispositivo di riproduzione predefinito: 
 
Windows XP: recarsi sul Pannello di controllo di Windows X Suoni e periferiche audio X scheda Audio e come 
dispositivo di riproduzione predefinito selezionare ‘USB Audio Codec’. Spuntare la casella per ‘Utilizzare unicamente 
dispositivi predefiniti’.  
 
Windows Vista: recarsi su Start X Pannello di controllo X Audio (in visualizzazione Classica). Quindi, cliccare 
sulla linguetta Registrazione ed evidenziare l’ingresso ‘Casse - (USB Audio Codec)’. Infine, cliccare su Applica per 
accettare le impostazioni.   
 
Windows 7: recarsi su Pannello di controllo X Audio e nella scheda riproduzione selezionare ‘Speakers - USB Audio 
Codec’.  
 
Mac OSX: si veda il paragrafo DISPOSITIVI AGGREGATI. 
 
6. Impostare l'NDX900 come dispositivo di riproduzione predefinito. Seguire le stesse fasi di cui sopra se si dispone 

di un secondo controller NDX900. 
 
DISPOSITIVI AGGREGATI (MAC)  
1. Cliccare sul desktop del Mac in modo che il Finder sia visualizzato nella parte superiore sinistra dello schermo. 
2. Selezionare il menu Go nella parte superiore dello schermo e scegliere Utilities. 
3. Nella finestra che si apre, fare doppio clic su Audio MIDI Setup. 
4. Una volta aperta l'utility Audio MIDI Setup, selezionare la scheda Audio in cima allo schermo; selezionare il 

menu Audio e scegliere Open Aggregate Device Editor. 
5. Nella finestra che si apre, cliccare il tasto + .  
6. Sotto Structure dovrebbero essere elencati quattro dispositivi USB Audio Codec. Se si utilizzano due NDX900s, 

ciascuno di essi sarà elencato come avente 2 ingressi e 2 uscite. Collocare un segno di spunta accanto a 
ciascuno dei quattro dispositivi USB Audio Codec elencati. In questo modo si fonderanno tutti e quattro i 
dispositivi USB Audio Codec in un solo dispositivo, consentendo al TRAKTOR LE2 di accedere a tutti gli ingressi 
e le uscite in una volta sola. 

7. Cliccare su "Done" (fatto). 
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4. SETUP DEL TRAKTOR LE 2 Procedura guidata di configurazione del TRAKTOR LE 2  
 
1. Dopo aver collegato l'NDX900 al computer tramite USB, lanciare il TRAKTOR LE 2. 
2. Quindi, in TRAKTOR LE 2, recarsi su Help > Start Setup Wizard. 
3. Nella finestra che si apre, cliccare su Next per arrivare a Traktor LE2 Controller Selection. 
4. Di fianco a Are you using an external controller? (si utilizza un controller esterno?) selezionare Yes (Sì), 

quindi cliccare su Next (avanti). 
5. Impostare il manufacturer (produttore) su Numark. Se si utilizzano due controller NDX900, impostare il model 

(modello) su NDX900 LE Dual Deck.  
Se si utilizza un solo NDX900, impostare model (modello) su ‘NDX900 LE Single Deck’ e cliccare su Next. 

6. Nella pagina di configurazione del mixer (Mixer Setup) di fianco ad Are you using an external mixer? 
selezionare No.  

7. Cliccare su Next e rivedere le configurazioni prescelte. 
8. Cliccare su "Finish" (finito).   
Setup dell'audio del TRAKTOR LE 2 (PC)  
1. Recarsi nel menu Preferences (opzioni) in TRAKTOR LE 2 per configurare Audio Setup. 
2. Recarsi su File > Preferences. 
3. Nell'area Audio Device area se ci si trova su piattaforma Windows assicurarsi che ASIO4ALL sia selezionato. 

Cliccare sul pulsante Settings per aprire la finestra di dialogo ASIO4ALL. Assicurarsi che lo status sotto a USB 
Audio Device (dispositivo audio USB) sia ‘attivo’ (evidenziato in blu) e chiudere la casella. In questo modo l'uscita 
audio del TRAKTOR LE 2 potrà essere inviata attraverso il collegamento USB all'NDX900 e trasmessa tramite 
l'uscita audio RCA USB. 

4. Per impostare la configurazione di ingressi e uscite audio cliccare su Output Routing sul lato sinistro della 
finestra "preferences" (opzioni) 

5. Sotto Mixing Mode (modalità di mixaggio), scegliere External (esterna). 
6. Sotto Output Deck A, scegliere USB Audio Codec 1 per ‘L’ e USB Audio Codec 2 per ‘R’. 
7. Sotto Output Deck B, scegliere USB Audio Codec 1 per ‘L’ e USB Audio Codec 2 per ‘R’. 

Se si utilizzano 2 deck NDX900:  
 • Sotto Output Deck A, scegliere USB Audio Codec 1 per ‘L’ e USB Audio Codec 1 per ‘R’. 
 • Sotto Output Deck B, scegliere USB Audio Codec 2 per ‘L’ e USB Audio Codec 2 per ‘R’. 
 

 
Setup dell'audio del TRAKTOR LE 2 (Mac)  
1. Cliccare sul menu TRAKTOR LE 2 nella parte superiore sinistra dello schermo e selezionare Preferences 

(opzioni). 
2. Sul lato sinistro della finestra che si apre, cliccare il + di fianco ad Audio Setup. 
3. Quindi, sotto Audio Setup sulla sinistra, cliccare su Soundcard (scheda audio). 
4. Sul lato destro della finestra, di fianco ad Audio Device, selezionare Aggregate Device. 
5. Sul lato sinistro della finestra "preferences" del TRAKTOR, sotto ad Audio Setup cliccare su Output Routing 

(convogliamento uscita). 
6. Sul lato destro della finestra, di fianco a Mixer Mode (modalità mixer), selezionare External (esterna). 
7. Di fianco ad Out Channel A, per Left (sinistra), selezionare Aggregate Device Out 1. Per Right (destra), 

selezionare Aggregate Device Out 2. 
8. Di fianco ad Out Channel B, per Left (sinistra), selezionare Aggregate Device Out 1. Per Right (destra), 

selezionare Aggregate Device Out 2. 
     Se si utilizzano 2 NDX900s, per Left (sinistra), selezionare Aggregate Device Out 3. Per Right (destra), 

selezionare Aggregate Device Out 4. 

Configurazione del manager del controller TRAKTOR LE 2  
Se si utilizza un singolo NDX900:  
Configurare l'NDX900 per il controllo di un Deck in TRAKTOR LE 2:  
 
1. Cliccare su Controller Manager sul lato sinistro della finestra Preferences (opzioni). 
2. Di fianco a Device, selezionare NDX900 Single Deck Controls.  
3. Sotto In-Port (porta di ingresso), selezionare Numark NDX900. 
4. Sotto Out-Port (porta di uscita), selezionare Numark NDX900. 
5. Di fianco a Device Target, selezionare Focus. 
6. L'NDX900 controllerà qualsiasi deck venga messo in evidenza (selezionato) sulla schermata principale del 

TRAKTOR LE 2. 
7. Per cambiare il deck in evidenza si può cliccare il tasto RECALL nell'angolo superiore destro dell'hardware 

NDX900, oppure utilizzare la tastiera o il mouse per selezionare il deck A o B dal software TRAKTOR LE 2.   
8. Cliccare su "Close" (chiudi).  
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Se si utilizzano due NDX900: 
 
1. Cliccare su Controller Manager sul lato sinistro della finestra "Preferences" (opzioni). 
2. Di fianco a Device, selezionare NDX900 Deck A Controls (qualsiasi deck venga collegato al computer per primo 

diventerà il ‘Deck A’.)  
3. Sotto In-Port (porta di ingresso), selezionare Numark NDX900. 
4. Sotto Out-Port (porta di uscita), selezionare Numark NDX900. 
5. Di fianco a Device, selezionare NDX900 Deck B Controls. 
6. Sotto In-Port (porta di ingresso), selezionare Numark NDX 900 #2. 
7. Sotto Out-Port (porta di uscita), selezionare NDX 900 #2. 
8. Cliccare su "Close" (chiudi).  
 
MAPPA DEI COMANDI 
 
 
1. EJECT (espulsione)  
2. USB MASTER 
3. SOURCE (fonte) 
4. TRACK KNOB (manopola) 
5. BACK (indietro)  
6. PLAY  
7. PAUSE (pausa)  
8. CUE  
9. ROTELLA JOG WHEEL 
10. SCRATCH 
11. SEARCH (cerca) 
12. STOP / START TIME (tempo di 

interruzione / inizio) 
13. TAP 
14. PITCH / KEYLOCK (pitch / blocco 

tonalità)  
15. FADER DEL PITCH 
16. BEND DEL PITCH 
17. INTERRUTTORE BLEEP / REVERSE   
18. LOOP IN / OUT / RELOOP  
19. TASTI TRIGGER  
20. SHIFT 
21. REC (registra)  
22. TASTO MODE (MODALITÀ)   
23. FX  
24. FX SELECT 
25. FADER WET / DRY   
26. PARAMETRO 
27. PROG (Programma)  
28. TIME (tempo)  
29. RECALL / STORE (richiama / 

memorizza) 
30. MODALITÀ DI RIPRODUZIONE (PLAY)  
31. DISPLAY LCD  
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SETUP von NDX900 UND TRAKTOR LE 2  

 
1. TREIBER-INSTALLATION (FÜR WINDOWS) 

 
1. Legen Sie die mitgelieferte Software-Installations-Disk in das DVD-Laufwerk Ihres Computers ein. 
2. Navigieren Sie zum Verzeichnis ASIO4ALL und suchen Sie die Datei ASIO4ALL.exe. 
3. Befolgen Sie die Anweisungen auf dem Bildschirm, um den mitgelieferten ASIO4ALL-Treiber für eine geringe 

Latenz zu installieren. 
 

2. SOFTWARE-INSTALLATION (TRAKTOR LE2) 
 
1. Legen Sie die mitgelieferte TRAKTOR LE 2 Software-Installations-Disk in das DVD-Laufwerk Ihres Computers ein. 

Windows: Doppelklicken Sie auf "Arbeitsplatz" und anschließend auf die Disk. Sobald der Inhalt der Disc 
angezeigt wird, doppelklicken Sie auf die TRAKTOR LE 2 Installationsdatei (.exe). 
Mac: Doppelklicken Sie auf die Disk. Sobald der Inhalt der Disk angezeigt wird, doppelklicken Sie auf die 
TRAKTOR LE 2 Installationsdatei (.dmg). 

2. Befolgen Sie die Anweisungen auf dem Bildschirm, um die Software zu installieren. 
Hinweis: Der TRAKTOR LE 2 Assistent könnte Sie auffordern, einen Hardware-Treiber zu installieren. Klicken Sie 
auf "Weiter" oder "Fortfahren“, um diese Anzeigen zu überspringen.  

3. Verbinden Sie Ihren NDX900 mit Ihrem Computer. (Wenn Sie Windows verwenden, kann es sein, dass Sie 
mehrere Dialogfelder in der Bildschirmecke sehen, die angeben, dass die Hardware zum ersten Mal "erkannt" 
wurde. Warten Sie eine Minute, bis dieser Vorgang abgeschlossen ist.) 

4. Öffnen Sie TRAKTOR LE 2. Im nun angezeigten Fenster klicken Sie auf die Schaltfläche "Aktivieren", um die 
Software zu registrieren. Das Native Instruments Service Center wird gestartet. (Sie müssen mit dem Internet 
verbunden sein, um Ihre Software im Service Center registrieren zu können.) 

5. Im Login-Fenster des Service Centers, klicken Sie auf "Neues Benutzerkonto anlegen" (falls Sie nicht schon 
über eines verfügen) und folgen den Anweisungen am Bildschirm, um Ihre Registrierung abzuschließen. (Dazu 
benötigen Sie die Seriennummer auf der mitgelieferten DVD-Hülle.) 
Hinweis: Weitere Hilfe und Informationen finden Sie im TRAKTOR LE 2 Handbuch. Gehen Sie dazu in Ihrer 
Software in das Menü "Hilfe".  

 
3. NDX900 SETUP 
 
1. Verbinden Sie den NDX900-Controller mit einem USB-Port an der Rückseite Ihres Computers. Schalten Sie den 

NDX900-Controller ein. 
2. Drücken Sie QUELLE.  
3. Drehen Sie den PARAMETER-Regler bis der Bildschirm <<SOURCE>> USB-MIDI anzeigt. 
4. Drücken Sie den PARAMETER-Regler (wie einen Knopf), um Ihre Auswahl zu bestätigen. 
5. So konfigurieren Sie den NDX900 als Standard-Wiedergabegerät: 
 
Windows XP: Öffnen Sie die Windows-Systemsteuerung X Sounds und Audiogeräte X Registerkarte Audio und 
wählen Sie als Standard-Wiedergabegerät "USB Audio Codec". Aktivieren Sie das Kontrollkästchen für "Nur 
bevorzugte Geräte verwenden".  
 
Windows Vista: Wählen Sie Start X Systemsteuerung X Sound (in der klassischen Ansicht). Gehen Sie dann auf 
die Registerkarte Wiedergabe und markieren "Lautsprecher-USB Audio Codec". Klicken Sie auf Anwenden, um die 
Einstellungen anzuwenden.  
 
Windows 7: Öffnen Sie die Windows-Systemsteuerung X Sounds und wählen bei der Registerkarte Wiedergabe 
"Lautsprecher- USB Audio Codec".  
 
Mac OSX: Siehe Abschnitt AGGREGATE DEVICES (Geräte-Editor). 
 
6. Konfigurieren Sie NDX900 als Standard-Wiedergabegerät. Befolgen Sie die oben genannten Schritte, wenn 

Sie einen weiteren NDX900-Controller haben. 
 
AGGREGATE DEVICES (MAC)  
1. Klicken Sie auf den Mac-Desktop, so dass Finder in der oberen linken Bildschirmhälfte erscheint. 
2. Wählen Sie das Go-Menü aus der oberen Bildschirmhälfte und wählen Sie Dienstprogramme. 
3. In dem sich öffnenden Fenster doppelklicken Sie auf Audio-MIDI-Setup. 
4. Sobald das Dienstprogramm Audio-MIDI-Setup  geöffnet ist, wählen Sie die Registerkarte Audio am oberen 

Bildschirmrand aus, wählen das Audio-Menü und Aggregate Device Editor öffnen. 
5. In dem sich öffnenden Fenster klicken Sie auf die Schaltfläche +.  
6. Unter Struktur sollten vier USB Audio Codec-Geräte aufgelistet werden. Wenn Sie zwei NDX900s verwenden, 

werden diese mit jeweils 2 Eingängen und jeweils 2 Ausgängen angeführt. Setzen Sie ein Häkchen neben jedes 
der vier aufgelisteten USB Audio Codec-Geräte. Dies wird alle vier USB Audio Codec-Geräte in einem Gerät 
zusammenfassen  und ermöglicht TRAKTOR LE2 auf alle Ein- und Ausgänge gleichzeitig zuzugreifen. 

7. Klicken Sie auf Fertig. 
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4. TRAKTOR LE 2 SETUP TRAKTOR LE 2 Setup-Assistent  
 
1. Schließen Sie NDX900 über USB an den Computer an und starten TRAKTOR LE 2. 
2. Navigieren Sie in TRAKTOR LE 2 zu Hilfe > Assistent starten. 
3. Im sich öffnenden Fenster klicken Sie auf Weiter, um zur Auswahl des Traktor LE2 Controllers zu gelangen. 
4. Neben "Verwenden Sie einen externen Controller?" wählen Sie "Ja" und klicken dann auf Weiter. 
5. Stellen Sie Numark als Hersteller ein. Wenn Sie zwei NDX900-Controller verwenden, stellen Sie als Modell 

NDX900 LE Dual Deck ein. Wenn Sie mit einem einzigen NDX900 arbeiten, stellen sie als Modell "NDX900 LE 
Single Deck" ein und klicken auf Weiter. 

6. Auf der Setup-Seite des Mixers neben "Verwenden Sie einen externen Mixer? " Wählen Sie "Nein".  
7. Klicken Sie auf Weiter und überprüfen die Einstellungen, die Sie gewählt haben. 
8. Klicken Sie auf Fertigstellen.   
TRAKTOR LE 2 Audio-Setup (PC)  
1. Gehen Sie in das Menü Einstellungen in TRAKTOR LE 2, um das Audio-Setup zu konfigurieren. 
2. Wählen Sie Datei > Einstellungen. 
3. Wenn Sie auf einer Windows-Plattform arbeiten, stellen Sie sicher, dass im Bereich Audio-Gerät ASIO4ALL 

ausgewählt ist. Klicken Sie auf die Schaltfläche Einstellungen, um das Dialogfeld ASIO4ALL zu öffnen. Achten Sie 
darauf, dass der Status unter USB Audio-Gerät "aktiv" ist (blau markiert) und schließen Sie dieses Fenster 
danach. So kann die Audio-Ausgabe von TRAKTOR LE 2 über die USB-Verbindung zum NDX900 gesendet und 
über den USB-Audio-Cinch-Ausgang ausgegeben werden. 

4. Um Ihren Audioeingang und -ausgang zu konfigurieren, klicken Sie auf Ausgangs-Routing auf der linken Seite 
des Fensters Einstellungen 

5. Unter Mixing-Modus wählen Sie Extern. 
6. Unter Ausgabe-Deck A wählen Sie USB Audio Codec 1 für 'L' und USB Audio Codec 2 für 'R'. 
7. Unter Ausgabe-Deck B wählen Sie USB Audio Codec 1 für 'L' und USB Audio Codec 2 für 'R'. 

Bei der Verwendung von 2 NDX900 Decks:  
 • Unter Ausgabe-Deck A wählen Sie USB Audio Codec 1 für 'L' und USB Audio Codec 1 für 'R'. 
 • Unter Ausgabe-Deck B wählen Sie USB Audio Codec 2 für 'L' und USB Audio Codec 2 für 'R'. 
 
TRAKTOR LE 2 Audio-Setup (Mac)  
1. Klicken Sie auf das Menü TRAKTOR LE 2 im oberen linken Bildschirmbereich und wählen Einstellungen. 
2. Auf der linken Seite des Fensters, das nun geöffnet wird, klicken Sie auf das + neben Audio-Setup. 
3. Dann klicken Sie auf Soundkarte unter Audio-Setup auf der linken Seite. 
4. Auf der rechten Seite des Fensters, neben Audio-Gerät wählen Sie Aggregate Device. 
5. Auf der linken Seite des Fensters Einstellungen für TRAKTOR klicken Sie auf Ausgangs-Routing unter Audio-

Setup auf der linken Seite. 
6. Auf der rechten Seite des Fensters, neben Mixer-Modus, wählen Sie Extern. 
7. Neben Ausgabekanal A für Links wählen Sie Aggregate Device Out 1. Für Rechts wählen Sie Aggregate 

Device Out 2. 
8. Neben Ausgabekanal B für Links wählen Sie Aggregate Device Out 1. Für Rechts wählen Sie Aggregate 

Device Out 2. 
Falls Sie 2 NDX900 verwenden, wählen Sie für Links Aggregate Device Out 3. Für Rechts wählen Sie 
Aggregate Device Out 4. 

Setup für TRAKTOR LE 2 Controller Manager   
Wenn Sie einen einzigen NDX900 verwenden:  
Richten Sie Ihren NDX900 ein, um ein Deck in TRAKTOR LE 2 zu steuern:  
 
1. Klicken Sie auf Controller Manager auf der linken Seite des Fensters Einstellungen. 
2. Neben Gerät wählen Sie NDX900 Single Deck Controls.  
3. Unter In-Port wählen Sie Numark NDX900. 
4. Unter Out-Port wählen Sie Numark NDX900. 
5. Neben Geräteziel wählen Sie Fokus. 
6. Der NDX900 wird nun jenes Deck steuern, das am Hauptbildschirm des TRAKTOR LE 2 im Fokus liegt 

(ausgewähltes Deck). 
7. Um zu ändern, welches Deck im Fokus liegt, können Sie entweder die Taste AUFRUFEN in der oberen rechten 

Ecke der NDX900 Hardware oder Ihre Tastatur oder Maus verwenden, um Deck A oder B innerhalb der 
TRAKTOR LE 2 Software auszuwählen.  

8. Klicken Sie Schließen.  
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Wenn Sie zwei NDX900 Einheiten verwenden: 
 
1. Klicken Sie auf Controller Manager auf der linken Seite des Fensters Einstellungen. 
2. Neben Gerät wählen Sie NDX900 Deck A Controls (das Deck, das Sie zuerst an den Computer angeschlossen 

haben, wird zu "Deck A".)  
3. Unter In-Port wählen Sie Numark NDX900. 
4. Unter Out-Port wählen Sie Numark NDX900. 
5. Neben Gerät wählen Sie NDX900 Deck B Controls. 
6. Unter In-Port wählen Sie Numark NDX 900 #2. 
7. Unter Out-Port wählen Sie NDX 900 #2. 
8. Klicken Sie Schließen.  
 
STEUERELEMENTE 
 
 
1. AUSWERFEN  
2. USB MASTER 
3. QUELLE 
4. TRACK-REGLER 
5. ZURÜCK  
6. WIEDERGABE  
7. PAUSE  
8. CUE  
9. JOGWHEEL 
10. SCRATCH 
11. SUCHEN 
12. STOPP- / START-ZEIT 
13. TAP 
14. PITCH / KEYLOCK  
15. PITCH-FADER 
16. PITCH-BEND 
17. BLEEP/RÜCKWÄRTS  
18. LOOP IN / OUT / RELOOP  
19. TRIGGER-TASTEN  
20. SHIFT 
21. REC  
22. (BUTTON) MODUS  
23. FX  
24. FX AUSWÄHLEN 
25. WET / DRY FADER  
26. PARAMETER 
27. PROG (Programm)  
28. ZEIT  
29. AUFRUFEN / SPEICHERN 
30. (WIEDERGABE) MODUS  
31. LCD-DISPLAY 
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